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1 INTRODUCTION 

The MultiComBox™ system connects a standard USB 2.0 port to one or two dual-redundant Mil-Std-1553 buses. 

Depending on the loaded firmware and configuration, MultiComBox™ can operate as Bus Controller (BC), Remote 

Terminal (RT), Monitor Terminal (MT), Multi-RT or as a full Mil-Std-1553 Tester. 

Depending on model, MultiComBox also supports additional avionics protocols like WB194, H009 and Extended Bit 

Rate 1553 (EBR1553). 

The system uses the high-speed USB 2.0 port from any desktop or laptop computer; loaded with Windows™ XP,  

Windows™ 2000 and Windows™ 7 OS, and can operate from the USB power, or using an external power supply. 

In some models, two RS-422 ports are also available for further testing and interface capabilities. 

As a 1553 bus tester, the MultiComBox™ unit provides full MIL-STD-1553B test, simulation and bus analysis 

capability in a compact self-contained unit. It supports concurrent Bus Controller (BC) and up to 31 Remote 

Terminals (RT) with Bus Monitor (MT). Full error injection capability is available in BC and RT modes, with full error 

detection in BC, RT and MT modes. 

The unit is supplied with Dynamic Link Library (DLL), together with a Windows Graphical User Interface (GUI), 

which includes the MuxMonitor™, MuxSim™ and mcxSIM™ tools, providing a user-friendly software tool for all 

1553 set-ups, simulation, data management and storage. 

It is possible to create your own testing program, using the supplied DLL and its functions. Please see the TesterDLL 

Programmers guide for details on how to use the Library. 
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2 SOFTWARE AND DRIVER INSTALLATION 

2.1 ABOUT MULTICOMBOX™ SOFTWARE 

The MultiComBox™ unit is provided with a Dynamic Library Link (DLL) and Graphical User Interface (GUI) software 

– MuxMonitor™ and MuxSim™. Also provided is mcxSIM™, which enables batch simulation and analysis. All these 

programs are discussed hereinafter. 

The DLL library is discussed in TesterDLL Programmers Guide. 

Depending on the type of hardware you use, the units require a driver to be installed. The installation program 

installs the required driver.  

In addition, the MultiComBox™ software uses the DotNet™ Framework, and thus requires a DotNet™ Framework 

version 2.0 to be installed in the working computer. 

All three items must be installed, and they are included in the installation program. 

To install the MultiComBox™ software please use the following steps: 

 Note: 

Run these steps before you connect the MultiComBox™ unit to the PC. 

 
If you downloaded the software from Sital Technology’s website (http://www.sitaltech.com) then you should 
download both the MultiComBox™ installation file and the DotNet Framework installation. If you are using the 
provided CD, then insert the CD into your CD drive. 

2.2 INSTALLATION OF MULTICOMBOX SOFTWARE: 
From the extracted files or from the CD, run ‘MCX_Setup_x.x.x.x.exe’ (x.x.x.x represents the version of the 
software). 
 
The following window will appear: 

http://www.sitaltech.com/
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Click “Next >”.  

 

 
 

Read the License Agreement. If you accept the agreement then select ‘I accept the agreement’ and then 

click on ‘Next >’. 
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Browse to a folder where you wish to install the program. The default location is “C:\Program 

Files\Sital\MultiComBox\” (for Windows XP OS) and “C:\Users\<current 

user>\AppData\Local\Sital\MultiComSoft  2.7.1.0” (for Windows 7 OS). 

Click on ‘Next >’. 

 

 
 

Select the components to install.  

It is recommended that you select “Full installation” or manually check the “MultiComBox QuickUSB 

Drivers”.  

If you are upgrading a previous version of MultiComBox, then you do not need to install the drivers again, 

hence you can un-check the “MultiComBox QuickUSB Drivers”. 

Click on ‘Next >’. 
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Select the folder name for the Start Menu. Default is “Sital MultiComBox 2.7.1.0”. 

Click on ‘Next >’. 

 

 
 

Click ‘Next >’. 

 

A summary of your selections will appear. Click on ‘Install’. 

Installation will commence, and the following window will appear: 
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This will install the MultiComBox™ files and drivers into your hard disk. Follow the instructions on the 
screen until installation is complete. 
 
When finished the following window will appear: 

 

 
 

Click on ‘Finish’ to exit the installation program. 
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2.3 INSTALLATION OF DOTNET FRAMEWORK: 

The .NET Framework is required in order to run MuxSIM and MuxMonitor. 

If you have not ran the .NET Framework installation before, then do the following: 

 
1. From the extracted files or from the CD, browse into the ‘DotNetFX’ directory. 
 

2. Run ‘dotnetfx.exe’. 
 

3. This will install the DotNet™ FrameWork into your hard disk. Follow the instructions on the screen until 
installation of DotNet™ Framework is complete. 

 

 

 Note: 

On some versions of Windows XP, on the first time that you connect the MultiComBox™ unit to the USB port a 

warning message may appear, indicating that the driver has not passed Windows Logo test. If this warning 

message appears, then click on “Continue Anyway”.  

When prompted, click on “Finish” to complete the “New Hardware Installation” wizard. 
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3 HARDWARE INSTALLATION 

3.1 USB CONNECTION 

 

Figure 1: USB Panel 

The USB panel of MultiComBox™ contains two similar connectors. The main USB connection is on the 

right side of the panel (3). The connection on the left (1) is used only if you need to connect external 

power to the unit. The power indication LED (2) will light when the unit is powered. 

3.1.1 USB POWER 

A USB 2.0 host is assumed to provide 5V DC and up to 0.5 Ampere of DC current. This is sufficient for the 

MultiComBox™ to operate both 1553 modules and all of the RS-485 connections simultaneously.  

Therefore, the preferred way to operate the MultiComBox™ unit is by using only the USB port (3) on the 

right side of the panel.  

However, there are cases in which a USB Hub or some Laptop computers are unable to provide the power 

defined by the USB standard, and thus an external power supply connection is available in the unit. This is 

the connector on the left side of the panel (1). 

A standard USB compatible power supply or an additional USB port from the USB hub or PC can be used 

for this purpose. 

Once power is supplied through the power connector, then the MultiComBox™ unit will not consume 

power from the USB port. 

 Note: 

It is always better to connect the unit directly to a PC or Laptop computer. If you use a USB HUB then you must 

provide external power to the unit, through the PWR connection. The unit will not operate properly if power is 

not provided. 
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3.1.2 USB DATA 

MultComBox™ connects to a host PC via a USB 2.0 connection. This connection uses high speed 480Mbps data 

transfer, and thus requires an appropriate cable. Please use only the provided USB cable. Using other USB cables 

may cause the unit not to work properly or not to work at all. 

The USB cable should be connected to the USB connection (3) and to any USB 2.0 port of your PC. 

 

3.2 MULTICOM CONNECTION 

 

Figure 2: MultiCom Panel 

The MultiCom Panel includes a 20 pin Mini-D-Ribbon connector (3) and two LED indicators (1 and 2). The MultiCom 

connectors in used for the 1553 and RS-485 connections and the LED indicators are used to monitor the activity in 

each 1553 module. 

In addition, the unit comes with a cable assembly that, according to the configuration you purchased, contains 4 

Triax connectors for 1553 and 1 female 9 pin D-type connector for RS 485, or 2 Triax connectors for a single Dual-

Redundant 1553 channel. These connectors are marked with accordance to the bus they should be connected to. 
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2 x 1553 and 4 x Serial channels 

 
 

1x 1553 channel 

Figure 3: MultiCom Cable Assemblies 

This cable should be connected to the “MultiCom” connector at the MultiComBox unit. 

 

3.2.1 1553 CONNECTION 

A MultiComBox unit contains an internal termination of 240 Ohm per each 1553 channel. Therefore, for a very 

simple test environment it is possible to connect the MultiComBox 1553 ports directly to the unit that is under 

test. 

 

Figure 4: Direct connection to unit under test 

Note that this is not a standard/recommended way to use Mil-Std-1553. Yet, for a simple test environment, if you 

plan to test your unit for its protocol capabilities, then this would be the simplest way to use MultiComBox. 

 

If you wish to connect via a 1553 coupler, then a simple Mil-Std-1553 test environment is typically connected in 

the following way: 

Module 1-A

Module 0-B

To Unit Under Test

Bus A

Bus B
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Figure 5: Mil-Std-1553 connection environment for single channel, via short stubs 

 

When a long cable is required, or if more units need to connect to the bus, then it is required to connect more than 

one coupler. Such connection will typically be done in the following way: 

 

 

Figure 6: Mil-Std-1553 connection environment for single channel, via long stubs 

 

In this example, only Bus 1A is used. When you need to connect other busses as well, for example Bus 2A, you 

would need to duplicate this connection, using an additional 1553 Coupler and cables. 

 

 Note 

Please note that Sital provides the MultiComBox™ and MultiComBox™ Cable Assembly. Couplers, Terminators 

and Stub Cables are not included in the delivery of MultiComBox™. These can be purchased separately. 

Coupler

78 Ohm 
Terminator

To Unit Under Test

To Unit Under Test

Coupler

78 Ohm 
Terminator

Coupler

78 Ohm 
Terminator
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MultiComBox™ enables you to connect up to two dual-redundant Mil-Std-1553 channels. These are marked at the 

cable assembly as “Module 0-A”, “Module 0-B”, “Module 1-A” and “Module 1-B”. When operating MuxSim™ and 

MuxMonitor™ software you will notice that the two channels are defined as Modules – “Module 0” and “Module 

1”. 

 Module 0-A represents BUS A in Module 0. 

 Module 0-B represents BUS B in Module 0. 

 Module 1-A represents BUS A in Module 1. 

 Module 1-B represents BUS B in Module 1. 

 

When operating a Dual-Redundant environment, you should not connect Module 0-A and Module 0-B on the same 

1553 Coupler, nor Module 1-A and Module 1-B. There must be a complete duplication of the connection in the 

following way: 

 

 

Figure 7: Dual Redundant 1553 test environment connection. 

Coupler

78 Ohm 
Terminator

To Unit Under Test

Coupler
78 Ohm 
Terminator

Bus A

Bus B
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When using both 1553 Modules on the same bus, for example – it is possible to use Module 0 as BC, RT or MultiRT 

and Module 1 as Monitor Terminal, or vice-versa. In such case, channels A of both modules and channels B of both 

modules can be connected to the same couplers, and so channel A of Module 0 will be connected to channel A of 

Module 1, and channel B of Module 0 will be connected to channel B of Module 1. 

 Note: 

Please note the importance of connecting the bus, couplers, stubs and terminators with accordance to the Mil-

Std-1553 standard. In most cases, faulty conditions are due to lack of good termination or bad connection of the 

bus. 

 

3.2.2 RS-485 CONNECTION 

MultiComBox™ enables up to 4 channels of RS-485. RS-485 is a two-wire, half-duplex, multipoint serial 

communications channel, that can be used for serial protocols or for discrete line as an event trigger. 

The four channels of RS-485 are available via the Female 9 pin D-type connector in the following manner: 

 

 
 

Pin Conn 

1 CH 1 + 

2 CH 1 - 

3 NC 

4 CH 2 + 

5 CH 2 - 

6 CH 3 + 

7 CH 3 - 

8 CH 4 + 

9 CH 4 - 
 

Figure 8: 9 Pin D-type for RS-485 

 

These channels are also used for Extended Bit Rate 1553 (EBR1553) where applicable. 

Pin 1Pin 5

Pin 6

Pin 9
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4 SOFTWARE OPERATION 

4.1 GENERAL DESCRIPTION 

MultiComBox™ software package consists of several components, which are located at the BIN directory under the 

installation of MultiComBox™ software: 

 MuxSim™ - a program that manages the simulation of a 1553 bus by creating messages and frames, 

controlling timing and rates of messages, selecting active busses and active Remote Terminals and re-

transmitting pre-recorded bus data. 

 MuxMonitor™ - a program that monitors the 1553 bus, records bus data into files, re-plays the recorded 

data in simulation or onto the real bus, enables filters and triggers for recording and re-playing. This 

program allows the user to track and follow bus messages, errors and any behavior that needs to be 

evaluated.  

 mcxSIM™ - a program that manages a batch based simulation of the 1553 and RS-485 MultiComBox™ 

buses by reading a command files which contains information of the required 1553 and RS-485 

communication (messages, frames, timing, rates, active busses, active Remote Terminals, etc…) and 

operate accordingly. 

 TesterDLL – a Dynamic Link Library module that serves software functions via API which operates the 

MultiComBox™. Software programmers should use this DLL file if they want to create their own 

application or GUI. More information on TesterDLL can be found on TesterDLL User’s Manual. 

 mcxB_x_x.RBF – a binary file that contains the firmware of MultiComBox™. This is the file that programs 

the internal Field Programmable Gate Array (FPGA) of the unit.  The “x_x” in the file name represents the 

version of the firmware.  

 Note: 

The MuxSim™ and MuxMonitor™ programs support messages from various protocols – Mil-Std-1553B, H009, 

PP194 and EBR1553. 

RS-485 is enabled by using the mcxSIM™ application and by the TesterDLL. 

If EBR1553 is supported then the Mil-Std-1553 ports are not in use. 
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5 MUXSIM™ - FRAME CREATION, SIMULATION AND TRANSMISSION 

To create new frames for simulation, transmission or re-transmit pre-recorded frames, use the MuxSim™ tool. 

From the directory of MultiComBox™ run ‘MuxSim.exe’. 

At start, the initialization window will appear. At this stage the software loads data and parameters onto 

MultiComBox. 

 

After a few seconds MuxSim main application window will be opened: 

 

Figure 9: MuxSim™ start 
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 Note: 

It takes a few seconds (up to 20) for the software to load. This is due to the loading of the MultiComBox™ 

firmware, which is done every time the MuxSim™ loads. 

5.1 MUXSIM™ FIELDS  

The MuxSim™ application contains several fields: 

 

Figure 10: MuxSim Fields 

5.1.1 FRAME TABS 

The main section of the screen contains tabs at which users can manage messages to be transmitted at a 1553 

frame. You can switch between frames, save frames to files or load pre-saved files. The Tab name is related to the 

name of the loaded/saved file. For example – a tab name of “Frame 0” is contained at the file “frame 0.xml”. 

5.1.2 SIMULATED UNITS 

In this field you can define which Remote Terminals (RT) should be simulated by MuxSim and which terminals are 

real on the bus. For example – if you test your real RT, which has an RT address “17” (for example), and you want 

RTs 11 and 12 to be simulated by MuxSim. In such case you will check the checkboxes for RTs 11 and 12. RT 17 will 

remain unchecked. Now you can create a frame which contains messages for RTs 11, 12 and 17. Messages for RTs 

11 and 12 will be answered by MultiComBox and messages for RT 17 should be answered by your RT. 



 MultiComBox™ August, 2013 

Sital Technology Ltd. 17 Atir Yeda St., Kfar-Saba, 44643, ISRAEL Page 22 

 

 

Figure 11: Simulated and Real units 

 

By clicking on “All Units Simulated” or “All Units Real” you can check or uncheck all checkboxes in one click.  

The data that is transmitted is defined by the data fields at the frame tab (D00 – D31). If a message is transmitted 

from an external RT or a UUT to MultiComBox, then the data displayed at the data fields is the real data that was 

received from the external RT. 

If the “Inject RT Data” checkbox is checked, then MultiComBox overrides the data set at the frame tab, and instead 

it will send incremental data to the bus. This checkbox also set all RTs as “Simulated”, and thus it should not be 

checked if your external RT needs to transmit data to the bus.  

How to create messages and frames is discussed in chapter 5.2 below. 

5.1.3 ERROR INJECTION 

In this section you can define errors to be injected to the bus. The default selection is “No Errors”. You can select 

between 4 errors – Parity, Bi Phase, Sync and Zero Crossing. Selection of each error will enable the relevant options 

for the specific error type. 

Errors can be set to messages 1 to 4 in the frame, and only one error per frame. However, you can check the “Auto 

Inc” checkbox, and the error will be injected to the following word on each transmitted frame. So, for example, if 

you set a Parity Error on message 1 and data word 02, then on the next frame the error will be injected to data 

word 03, and on the next frame to data word 04 and so on. 

Error injection operation is discussed in chapter 5.5. 

 

RT 11
(Simulated)

RT 12
(Simulated)

UUT
RT17
(Real)
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5.1.4 FRAMING 

The “Framing” section defines the amount and rate of the frames to be transmitted.  

You can select between a single shot of transmission, ‘n’ times or Continues transmission. When you select ‘Single’ 

then after pressing the “Run” button your frame will be sent once, and then stop. You can define how many times 

a frame will be sent by selecting the ‘n’ times and typing in the required number of times. ‘Continues’ will cause 

the system to transmit all messages until the “Stop” button at the Run Control section is pressed. 

In a normal 1553 bus a rate of 50Hz is typically used. However, for debugging and monitoring purposes it is 

possible to define a higher or lower rate of down to 1 frame per second. 

You can also define this by time of each frame, instead of the rate. For example – rate of 50 frames per second is 

equal to 20,000 microseconds per frame. 

5.1.5 RUN CONTROL 

The “Run Control” section enables running and stopping the run of a frame, selecting which module is operational, 

defining whether Bus Controller is at MultiComBox or external and controlling the Transmit Inhibitor. 

You can select between Module 0 and Module 1 of MultiComBox.  

You can also select between “BC + MultiRT” and “MultiRT Only” options. In a typical operation environment, where 

MultiComBox initiates all communications on the bus, the Bus Controller (BC) is part of MultiComBox. In this case 

you should select the “BC + MultiRT” option. In cases where the Bus Controller is external to MultiComBox, and 

you wish MultiComBox to simulate other Remote Terminals on the bus, then the “MultiRT Only” option should be 

selected. MultiRT feature is discussed in chapter 5.4. 

After you enter all messages, select which RTs are simulated or real, set the desired Framing parameters, select 

which module to operate and select the BC or Multi-RT options, then you can press the “Run” button. When the 

system is running, the Run button will turn green and will enable you to Stop the running. 

The “Inhibit TX to the Bus” checkbox is checked, then all bus activity is internal to MultiComBox, and no bus signals 

will be transmitted to the bus. Use of this option is typically done for testing purposes. 

5.2 CREATING, SETTING AND TRANSMITTING A 1553 FRAME 

5.2.1 CREATE A NEW FRAME 

You can create several frames, with different messages in each frame. Each frame is shown as a tab in the Frames 

Tabs area. Each frame contains one or more messages. 

A new frame is created by selecting File -> New Frame from the file menu, pressing Control+N or clicking on the 

“New Frame” button at the top menu. 
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5.2.2 ADDING AND MANAGING MESSAGES 

To add new messages into a frame, simply start inserting the appropriate data in the messages list. Pressing 

<Enter> on any of the fields will automatically define a new ‘Broadcast’ message from BC, with all data set to zero. 

 

Figure 12: A new MuxSim message 

 Note: 

Every time you press <Enter> at the last message on the list, you add a new message. 

Pressing <Enter> on any other message will move the cursor to the same field, one message (line) below. 

Pressing <Tab> on any field will move the cursor to the next field on the same message. 

Data can be set by clicking on the appropriate field and entering the data, or by selecting from a list of possible 

configurations. For example, the ‘Bus’ field can be set either to Bus A or Bus B, while the data fields can be 

manually configured.  After configuring a field, press <Tab>, <Enter> or select another field with the mouse. Data 

will not be set if you stay on the same field after modifying it. 

To delete a message select the message by clicking on the number at the left of the message. The message will be 

selected. Then press <Delete>. 

5.2.3 MESSAGE FIELDS 

The following fields are available (see Figure 13: below): 

En  Use this checkbox to enable or disable the message from the frame. 

Title  Alphanumeric title of a message. 

Protocol  1553 or PP194 (WMUX) 

Bus 1553 bus A or B 

Gap Gap between messages in microseconds. 

Type Select the type of message.  
Selection includes: Generic, BC->RT, RT->BC, RT->RT, Broadcasts, all command messages, all 
Broadcast Commands and messages without Data. See software for all options. 

From Source of message. Can be BC, any RT or Broadcast. 

SrcSA Source Sub-Address. Can be between 0 and 31. 

To Destination of message. Can be BC, any RT or Broadcast. 

DstSA Destination Sub-Address. Can be between 0 and 31. 

WC Word Count – how many data words per message. Can be between 1 and 32. 

Errors When running, this fields shows errors that occur during the run. If there is an error, then clicking 
on this field will open the error popup. 

TX Status Transmit Status Word – shows the result of the Transmit Status Word, when relevant. 

RX Status Receive Status Word – shows the result of the Receive Status Word, when relevant. 

Times Sent Counts the times that a message was sent from “Run”. 
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Error Count Counts the amount of errors per message. A “?” indicates that MultiComBox could not count the 
amount of errors, usually due to over load. 

D00 to D31 Data Words 00 to 31. 
You can enter data to be transmitted in each message. Data cannot be modified once the system is 
in “Run” mode. 
Selecting “Inject RT Data” at the “Simulated Units” field, will change the data incrementally during 
Run. 
For “Real RTs” (selected at “Simulated Units” field) the data shown is the data received from the 
external RT, relevant to the message. 

Remark Alphanumeric field for remarks on a message. 

 

 

Figure 13:  MuxSim™ Frame Creation 
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5.2.4 LOADING A PRE-SAVED OR RECORDED FRAME 

Clicking on “Frame -> Open” from the main menu will open a saved frame. 

Saved frames can be either a frame that was defined before with MuxSim™, or a frame that was saved from 

MuxMonitor™. 

Previously saved frames with MuxSim™ are saved with the extension “.XML”. This is the default extension which 

MuxSim™ is looking for, when opening an existing file. 

To open a XML file that was previously saved by MuxMonitor™, after using Frame -> Open menu, from the Open 

menu, browse to the location where you saved your XML file. 

Each new file that you open will open a new TAB, with the tab name same as the file name. 

5.2.5 SETTING ADDITIONAL PARAMETERS FOR TRANSMISSION 

Before transmitting data to the bus, you also need to set some additional parameters: 

1. Simulated Units – Select which RTs are real and which are simulated. 
2. Framing – Select the number of times the frame should run – Single, n times or Continuous. 
3. Frame Frequency – set the frequency of the frame. Typically 50Hz, or 20,000 microseconds. 
4. Module – Which of the 1553 modules should be used. 
5. BC + MultiRT or MultiRT Only – select mode of operation. 

5.3 RUNNING THE FRAME 

To run the frame, simply click on “Run” button at the Run Control menu. 

The frame will run with accordance to the configuration of the “Framing” section – Single, n times or Continuous. 

If the ‘Continuous’ option is selected, then the frame will run until the user presses the “Stop” button. 

While running you cannot update or change the frame. Modifying the frame can only be done while the system is 

not running. 
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5.4 “MULTIRT ONLY” OPERATION 

5.4.1 FUNDAMENTALS 

MultiRT (MRT) is used when an external bus controller (BC) manages the bus and MultiComBox™ emulates RTs on 

the bus. 

It is assumed that the remote BC runs in frames, and that each frame has got at least 4ms of dead bus time. 

5.4.2 ENABLING MRT 

To enable MultiRT Only mode select this option from the Run Control area. To start the RTs responding enable the 

desired RTs for emulation at the Simulated Units area, set the expected frame time length, select “Continues” on 

the Framing area and press the “Run” button. 

5.4.3 OPERATING MRT IN MUXSIM™  

There are three options to define the messages that RTs should respond to: 

1. No messages are set in the frame. Messages will be replied with no error, with all data set to zero (or 

increments if “Inject RT Data” is set). In this mode, all messages are replied by MultiComBox for RTs that 

are set as “Simulated”. 

2. Set the desired messages in the frame. The configured messages will be transmitted upon request from 

the BC. Note that the RTs must be enabled as “Simulated” in order for MultiComBox to respond. 

Messages that are not configured, but are set as “Simulated”, will respond with all data set to zero. 

3. RT to RT messages:  

Once an RT2RT message is received, the MRT HW searches this message, both in the first command and in 

the second command and replies for the transmitting RT or the receiving RT depending on the RT 

simulation setup.  

The following example shows a MultiRT configuration. In this example participate RTs 00, 01, 02 and 03. Messages 

1 and 2 define messages from RT00 to RT01 (RT to RT), message 3 is a message from BC to RT02 and message 4 is a 

message from RT02 to BC. 

Parameters like Sub-Address and Word-Count are also set to the expected parameters. 

Whenever a command that represents one of these messages appears on the bus, then MultiComBox will respond 

with the configured message. 

RTs 00, 01, 02 and 03 are set as “Simulated”. 
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Figure 14: MultiRT operation 

When a command is received from the BC, it is compared to the messages that are set. If a command for RT02 

transmit, at Sub-Address = 1 and Word-Count = 2 is received, then MultiComBox will transmit message 4 to the 

bus. 

If a command for RT03 transmit is received, then MultiComBox will respond with the requested message, Sub-

Address and Word-Count, as requested by the BC. 

A command for RT04, or any other RT that is not set as “Simulated”, will not be responded by MultiComBox.  

If the BC requests a different Sub-Address than the one set at the Frame, then MultiComBox will respond to the 

requested message with no errors. 

If the BC requests a message that is set at the frame, but with a different word-count – for example: RT02 to BC, 

Sub-Address = 1, Word-Count = 3 – then MultiComBox will transmit the message, as set at the Frame (with Word-

Count = 2) and report a Word-Count Error. 

 Note:  

In order to operate MultiRT Only mode you must press the Run button. 
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5.5 ERROR INJECTION 

MuxSim supports the following errors: Parity, Bi Phase, Sync. and Zero-Crossing. 

To operate an error, select the error from the Error Type drop-down menu. Once an error is selected, additional 

menus will be opened, which are relevant to the selected error. 

5.5.1 PARITY ERROR 

Purpose: Verify the UUT’s capability to detect Parity Errors embedded in different Data Words within a Message. 

Description: Inject a wrong Parity bit in the selected Word within a Message. A Parity Error can be set in any of the 

available Message Words including commands, status and data words with accordance to the message type. 

Restrictions:  

 Parity Error can be set in Messages 1 to 4 in each Frame.  

 Only a single Message can be selected within a Frame. 

 Only a single Parity Error can be set within a Message. 

GUI Controls: 

 Message: 

o Action: Select the Message in the current Frame to inject a Parity Error. 

o Available values: 1 – 4 

 Word:  

o Action: Select the Word to embed the Parity Error.  

o Available values: Transmit CMD, Receive CMD, Transmit Status, Receive Status, Data 00 – Data 

31. 

o Restrictions: Selected Word should exist in the selected Message. 

 Auto Inc:  

o Action: Automatically inject the Parity Error to the next word for each Message transmission. 

Auto Inc is starting from the selected Word for each new Run (clicking the Run button). Auto Inc 

operation is Cyclic inside the Message - Error will move to the first Word of the Message after 

reaching the last Word and so on. 

o Restrictions: Auto Inc works only in case of Continues or #N times Run. 

Reference: Paragraph 5.2.1.3.1 in RT Validation Test-Plan 

5.5.2 BI PHASE ERROR 

Purpose: Verify the ability of the UUT to recognize lack of a zero crossing in the center of a bit time. 
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Description: Inject a Bi Phase Error bit in the selected Bit within a Word within a Message. A Bi Phase Error occurs 

as either a logic high or low for the duration of a Bit time. In order to achieve the Bi Phase error, the second half 

logic of the selected Bit will be equal to the first half logic.  

A Bi Phase Error can be set in any Bit within any Word of the available Message Words including commands, status 

and data words with accordance to the message type. 

Restrictions:  

 Bi Phase Error can be set in Messages 1 to 4 in each Frame.  

 Only a single Message can be selected within a Frame. 

 Only a single Bit can be selected within a Message. 

 Bi Phase Error can be set only in Data and Parity Bits (not in Sync bits). 

GUI Controls: 

 Message: 

o Action: Select the Message in the current Frame to inject a Bi Phase Error. 

o Available values: 1 – 4 

 Word:  

o Action: Select the Word to embed the Bi Phase Error. 

o Available values: Transmit CMD, Receive CMD, Transmit Status, Receive Status, Data 00 – Data 

31. 

o Restrictions: Selected Word should exist in the selected Message. 

 In Bit: 

o Action: Select the Bit to embed the Bi Phase Error. 

o Available values: Data 0 – Data 15, Parity. 

o Restrictions: Bi Phase Error can be set only in Data and Parity Bits (not in Sync bits). 

 Auto Inc:  

o Action: Automatically inject the Bi Phase Error to the next Bit for each Message transmission. 

Auto Inc is starting from the selected Bit for each new Run (clicking the Run button). Auto Inc 

operation is Cyclic inside the Message - Error will move to the next Bit inside a Word till the last 

Bit, then, will move to the first Bit of the next Word within the message. After reaching the last 

Bit of the last Word it will jump to the first Bit of the first Word and so on. 

o Restrictions: Auto Inc works only in case of Continues, or #N times Run. 

Reference: Paragraph 5.2.1.3.3 in RT Validation Test-Plan 

5.5.3 SYNC ERROR 

Purpose: Verify the ability of the UUT to recognize Sync Errors. 

Description: Inject a wrong Sync pattern in the selected Word within a Message. A proper Command Sync pattern 

is represented as 111000 and a proper Data Sync is represented as 000111 (the sync pattern is a waveform with six 
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0.5μs divisions represented as a 1 or 0 to indicate the polarity). A wrong Sync pattern can be injected in any Word 

of the available Message Words including commands, status and data words with accordance to the message type. 

Restrictions:  

 Sync Error can be set in Messages 1 to 4 in each Frame.  

 Only a single Message can be selected within a Frame. 

 Only a single Word can be selected within a Message. 

GUI Controls: 

 Message: 

o Action: Select the Message in the current Frame to inject a Sync Error. 

o Available values: 1 – 4 

 Word:  

o Action: Select the Word to embed the Sync Error. 

o Available values: Transmit CMD, Receive CMD, Transmit Status, Receive Status, Data 00 – Data 

31. 

o Restrictions: Selected Word should exist in the selected Message. 

 Sync Pattern: 

o Action: Select the Sync Pattern to inject in the selected Word. 

o Available values: 111100 , 110000 , 111001 , 011000 , 000011 , 001111 , 000110 , 100111, 

Inverted. 

 Auto Inc:  

o Action: Automatically inject the Sync Error to the next word for each Message transmission. Auto 

Inc is starting from the selected Word for each new Run (clicking the Run button). Auto Inc 

operation is Cyclic inside the Message - Error will move to the first Word of the Message after 

reaching the last Word and so on. 

o Restrictions: Auto Inc works only in case of Continues or #N times Run. 

Reference: Paragraph 5.2.1.3.4 in RT Validation Test-Plan 

5.5.4 ZERO CROSSING ERROR 

Purpose: Verify the ability of the UUT to function properly with different Zero Crossing. 

Description: Inject a Zero Crossing Error in the selected Bit within a Word within a Message. Zero Crossing can be 

inserted in any half bit of each word. This Error would either expedite the arrival of the next zero Crossing, or skew 

it away by the amount defined in the Skew Control. A Zero Crossing in some of the bits might skew the Zero 

Crossing of the next bit. This will always happen during the Sync in bit 0 and 2, and in 2
nd

 half of bits that are 

followed by an opposite bit value. 

A Zero Crossing Error can be set in any Bit within any Word of the available Message Words including commands, 

status and data words with accordance to the message type. 
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Restrictions:  

 Zero Crossing Error can be set in Messages 1 to 4 in each Frame.  

 Only a single Message can be selected within a Frame. 

 Only a single Bit can be selected within a Message. 

GUI Controls: 

 Message: 

o Action: Select the Message in the current Frame to inject a Zero Crossing Error. 

o Available values: 1 – 4 

 Word:  

o Action: Select the Word to embed the Zero Crossing Error. 

o Available values: Transmit CMD, Receive CMD, Transmit Status, Receive Status, Data 00 – Data 

31. 

o Restrictions: Selected Word should exist in the selected Message. 

 In Bit: 

o Action: Select the Half Bit to embed the Zero Crossing Error. 

o Available values: Sync0 – 1
st

 Half …  Sync2 – 2
nd

 Half ,  

                               Data0 – 1
st

 Half …  Data15 – 2
nd

 Half,  

                               Parity – 1
st

 Half , Parity – 2
nd

 Half 

 

 

 

Figure 15: Zero Crossing Error injection 
 

 Skew: 

o Action: Set the skew time (in ns) of the next Zero Crossing (expedite in case of negative values). 

o Available values: +233, +200, +166, +133, +100, +66, +33, 0 , -33, -66, -100, -133, -166, -200, -233 

 Auto Inc:  

o Action: Automatically inject the Zero Crossing Error to the next Half Bit for each Message 

transmission. Auto Inc is starting from the selected Half Bit for each new Run (clicking the Run 

button). Auto Inc operation is Cyclic inside the Message - Error will move to the next Half Bit 

inside a Word till the last Half Bit, then, will move to the first Half Bit of the next Word within the 

Data7 –2nd Half

Sync0 – 1st Half

Sync0 –2nd Half

Sync1 –2nd Half

Sync1 –1st Half

Data7 – 1st Half
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message. After reaching the last Half Bit of the last Word it will jump to the first Half Bit of the 

first Word and so on. 

o Restrictions: Auto Inc works only in case of Continues, or #N times Run. 

Reference: Paragraph 5.1.2.1.1 in RT Validation Test-Plan 

5.6 COMMAND LINE ARGUMENTS 

MultiComBox™ MuxSim™ software supports several command line arguments to control its mode of operation. In 

order to use these arguments, the relevant switches should be included in MuxSim™ run command: 

 -UserCodeM0=<parameter> – Set special mode of operation to Module 0 of MultiComBox™ 

 -UserCodeM1=<parameter> – Set special mode of operation to Module 1 of MultiComBox™ 

The UserCode parameters are checked on a ‘bit’ basis, so you can set several user codes with the single argument. 

For example: Parameter = 1040 will set both routing via RS-485 and Swap of Bus signals. See below for further 

details: 

5.6.1 ROUTING 1553 SIGNALS VIA RS-485 CHANNELS 

Parameter = 1XXX – The MIL-STD-1553 communications of Bus A (in the selected module) is routed via the RS-485 

serial channels. Incoming communication from the 1553 channels use the serial RS-485 lines only. Inputs from the 

1553 channel are ignored. 

MIL-STD-1553 BUS-A communication is routed to the RS-485 4 channel lines as follow: 

 Tx on RS-485 CH1 

 TxN on RS-485 CH2 

 Rx on RS-485 CH3 

 RxN on RS-485 CH4 

 

Examples:  

muxsim.exe –UserCodeM0=1000 

muxsim.exe –UserCodeM1=1000 

5.6.2 SWAP SIGNALS ON BUS B 

Parameter = XX4X – The Busses A and B will be inverted between “+” and” –“ signals. 

 

This is useful to detect inverted wiring on a system. For example, if there are too many errors reported during 

communication, it is possible to invert the signals and test again. 

 

Examples: 

muxsim.exe –UserCodeM0=0040 

muxsim.exe –UserCodeM1=0040 
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5.7 VERSION’S NEW FEATURES 
The following features were added to the current MuxSim version: 

1. Right Click Menu – new selection and actions 

a. Right Click Menu – over Information columns 

Once clicking using the mouse right click, a menu opens containing the following options: 

 
i. New Message – creating a new message, added last in the messages  

ii. Select Message – selecting the message located under the cursor  

Note – selecting a message can be done by click on the most left column in the table 

iii. Copy selected Messages – copies the selected message/s (storing them in clipboard) 

iv. Paste Messages – duplicating the messages previously copied 

v. Delete Selected Messages – delete all messages marked as selected 

vi. Copy & Revert selected Messages – copy selected messages and swapping the From <-> 

To fields and the SourceSA <-> DestinationSA fields. 

vii. Enable All – mark as checked all messages (En -> enable column) 

viii. Enable Selected – mark as checked all selected messages (En -> enable column) 

ix. Disable All – mark as un-checked all messages (En -> enable column) 

x. Disable Selected - mark as un-checked all selected messages (En -> enable column) 

b. Right Click Menu – over Data columns 

Once clicking using the mouse right click, a menu opens containing the following options: 

 
i. Fill 0x0000 - Fill all data cells with 0000 

ii. Fill 0xFFFF - Fill all data cells with FFFF 

iii. Fill 0x5555 - Fill all data cells with 5555 

iv. Fill 0xAAAA - Fill all data cells with AAAA 

v. Increment From First - Fill all data cells with incrementing values starting from the value 

in the first data column 

vi. Random - Fill all data cells with random 4 digits (0000 - FFFF) 

vii. Invert Bits - Inverting Bits for each cell value to the complementary value 
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2. Frame Tabs swap 

Swap Frame tabs location by drag & drop Frame’s tab 

3. Running Frame tab’s color 

Once a Frame is running (Run button is in ‘Run’ state) the tab header color turns to Green 

4. New quick access icons menu bar 

a. Reset Device Connection 

 
Reset device connection terminates the connection to the device and re-initialize it. 

b. Launch MuxMonitor 

 
Runs a MuxMonitor Application. 

5. Device number indication 

Device number added to the top left header of the application 

6. Multi-Devices intro menu 

Once running MuxSim while working with more than a single device, a ‘Select Device’ window containing 

all identified devices pops.  

 
On selecting device and pressing OK, MuxSim of the selected device loads. 
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6 MUXMONITOR™ - MONITOR, RECORD AND RE-PLAY 1553 DATA 

6.1 STARTING MUXMONITOR™  

“MuxMonitor™” is used to monitor, record and re-play all of the data on the bus. 

To run MuxMonitor™ double-click on the MuxMonitor™ icon, or run “MuxMonitor.exe” from the BIN directory of 

MultiComBox™. 

The first window that appears is the following: 

 

Figure 16: MuxMonitor™ Opening Window 
 
The first thing you must define what you want the system to do. The options are: 
 

 New Monitor – Monitor a new sequence with blank filters, 
triggers and other parameters,  

 Open Monitor (not active in this version) – Monitor a new 
sequence using pre-defined filters, triggers and other 
parameters or  

 Playback Recorded Data – Re-play an existing pre-recorded 
monitor file. 

 
You do that by clicking on the “File” menu and selecting the appropriate 
option, as seen on the right: 
 

 
Figure 17: MuxMonitor™ File Menu 

 Note: 

When you select ‘New Monitor’ option, if MultiComBox™ was not initialized before by MuxSim™ or another 

application, then MuxMonitor™ will initialize the MultiComBox™ unit. This happens on every time you start a new 

monitor. 
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6.2 MUXMONITOR™ OPERATION 

The Monitor screen is divided between four main sections: 

1. Top menus and controls 
2. Tabs at the top, containing a list of messages from the bus. 
3. Tabs at the mid-bottom section, containing setups for filters, triggers and search criteria. 
4. LED indicators of the errors status of each RT. If an error occurred then the LED of the appropriate RT will 

light in red. If the error stops, then the LED will turn to orange. 

6.2.1 TOP BAR MENU 

The following controls are available at the top section of the screen: 
 

 

Figure 18: MuxMonitor™ Control Icons 

Controls that are not relevant for the specific status of the program are grayed, and only those that are relevant 

are colored. The following section explains the meaning of each icon in the menu bar: 

 Start Monitoring – will turn the Monitor on. 

 Stop Monitoring – will turn the Monitor off. 

 Freeze Display – Freezes the updates on the screen. Data will still be processed by the monitor or saved into 
a file, but the display will not change. 

 Unfreeze Display – turns on the updates on the screen. Data will be updated upon the arrival of a new 
message. If the display was freeze, and no messages are on the bus, then unfreezing will have no effect until 
a new message appears.  

 Clear Display – removes all the messages from the list and reset all counters. 

 Start Recording – will start the recording of the data on the bus into a new file. The file will be named with 
accordance to the current date and time. 

 Stop Recording – will stop the recording of the data into the file. 

 Reset Errors – will reset the status of the LEDs at the bottom. If an error occurred at an RT, and its LED 
indicator at the bottom of the screen is red or orange, then clicking on this button will reset the LED to its 
current status. 

 Properties – Open the Tab’s properties window. 

 Show/Hide Messages Data Columns – this button will toggle between displaying the data from the 
messages or just display the status, counters and errors. Use this button to reduce the amount of items 
displayed on the screen. 

 Resize Column Width – will set the width of columns to the fit the displayed data automatically. 

 Enlarge Columns – will increase the width of all columns. 
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 Narrow Columns – will decrease the width of all columns. 

6.2.2 MONITOR TABS 

The Monitoring Tabs show either all the data monitored from the bus, or data that is being played-back by 

MuxMonitor™.  

 

Figure 19: MuxMonitor™ monitor tab 

At the header of each tab appears the Device number, which is a unique number for each MultiComBox™ unit. If 

more than one unit is connected to the PC, then you can open a new monitor for each device, and this will be 

represented at the tab header.  

The Monitor tab shows all the data as it comes from the bus or re-played from file. This data include the following 

fields: 

 Act (Activity) – every new message makes this area green for 0.3 second. If a message appears on every 
frame or every few frames, then this area will be constantly green. When there is an error, then this area 
will become red, until the error disappears (for example, in the next frame). Then this area will become 
Orange, until “Reset Errors” is selected. 

 Bus – shows from which module (0 or 1) and from which bus (A or B) was this message. 

 Time – shows the time of the last appearance of the message. Every time a message appears again (for 
example, in the next frame) the time will be updated. This is the computer time. 

 Type – shows the type of message – 1553, PP-194, H009, etc. 

 From – the sender of the message. 

 To – the recipient of the message. 

 SrcSA – Source Sub Address. 

 DstSA – Destination Sub Address. 

 WC/MC – Word Count / Mode Code. 

 Tx Status – The transmit Status Word. 

 RX Status – The receive Status Word. 

 Times Sent – The number of times this message appears since we started the monitor or since we reset 
the monitor. 

 Error Count – Shows errors related to the message. When error appears then clicking on the error button 
of the message will pop-up the list of errors related to the message. 

 D00 to D31 – The data sent on the bus. 
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6.2.3 DISPLAY FILTER, TRIGGER AND SEARCH CRITERIA  

The following paragraphs discuss the Display Filter. The exact same controls also apply to Triggers and Search 

Criteria. 

The Display Filter controls which messages will be shown and updated at the messages tab. By default, all 

messages are shown. The user may apply a filter on any aspect of the message, including protocol type, source, 

destination, which bus, sub-addresses, word-count and the data itself. 

 

Figure 20: Display Filter 

Each line in the filter represents a logic AND function between the terms in that line. This means that only when 

ALL terms are compiled then the message will be shown. For example – if you want to filter messages from RT 26, 

with data word 02 larger than 64 then you would put these two terms in the same line. 

Between the different lines of the filter there is a logic OR function. This means that when a message complies 

with one of the lines of the filter, then the message will be shown at the messages tab. if you applied a filter to 

show only RT 26 in one line and RT 27 in another line, then both RTs will be shown at the messages tab. 

Some of the fields are selectable and some open a menu from which you can define the filter for that field. The 

following table explains the different fields and available parameters: 

Field Type Meaning Parameters 

Standard Select Which Protocol 1553, PP194 

Bus Select Which Module and bus A0 – Module 0, Bus A 
B0 – Module 0, Bus B 
A1 – Module 1, Bus A 
B1 – Module 1, Bus B 

From Select  BC, any of the RTs 

SrcSubAddr Select Source Sub-Address Any number between 0 – 31  

To Select  BC, any of the RTs 

DstSubAddr Select Destination Sub Address Any number between 0 – 31 

WprdCount/ModeCode Select Word count or Mode Word Any number between 0 – 32 

D00 – D31 Open menu Data words See below 

Tx Status Open menu Transmit Status word See below 

RX Status Open menu Receive Status word See below 

Error Select  Error, No error 
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To manage the Data and Status Words filters click on the button of the word you wish to edit. A menu will be 

opened: 

 

Figure 21: MuxMonitor™ Word Filter 

From this menu you can manage each bit on the data words. You can assign filter for certain bits to be ‘0’, ‘1’ or if 

you don’t mind the status of a particular bit, then assign it to ‘X’. 

You can also set the value of the word, with options of “equal to” (=), “greater than” (>), “smaller than” (<) or “Not 

Equal to” (~). 

6.2.4 THE LED INDICATORS AREA 

The LED indicators area shows the activity status of each RT in each module and the load on the bus. 

 

Figure 22: LED Indicators Area 

When there is activity at a Remote Terminal (RT) then a green LED will blink for 0.3 second, at the location 

representing the RT number. When the activity ends the LED will stop lighting and will become white. 

If there is an error related to a Remote Terminal, then the LED will become RED, as long as there is activity on the 

bus for that RT. When the activity stops then the LED will stop lighting and will become white again. If in the 

following frames the error disappears, then the LED will become yellow. 

Clicking on “Clear Display” will reset the LEDs. 

At the right side of the LED Indicators Area you can see the bus load for each module. The bus load represents the 

percentage of time in which the bus is busy. 
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6.3 NEW MONITOR 

6.3.1 GENERAL DESICRPTION 

Selecting this option will open a new tab and enable monitoring and recording of the bus. 

 Note: 

To start a new monitor a MultiComBox™ unit has to be connected to the computer on which you run the 

program, as this takes real data from the network and shows it on the screen or records it into a file. If no 

MultiComBox™ unit is present or if MuxSim™ is not running, then an error message will appear. 

When the monitor starts it is ready to accept messages and display it on the screen.  Now some features will be 

enabled on the MuxMonitor™ window, and the screen will look like this: 

 

Figure 23: New Monitor screen 
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Once new messages start to arrive from the bus then lines will be added to the screen – one line per each new 

message.  

 

Figure 24: Monitor Messages 

When a message is transmitted again in a following frame, then it is also updated on the screen, and the “Time 

Sent” parameter is updated. Each updated message overrides the previous parameters and data, but “Time Sent” 

and “Error Count” fields are incremental. 

As discussed in paragraph 6.2.1: 

 While monitoring you can stop and start the monitor, by clicking on  or . 

 You can freeze and unfreeze the display, or clear the display and reset the counters by clicking on ,  

or . 

6.3.2 RECORD DATA 

To start recording to a file, use the  button. 

MuxMonitor™ will create 3 files: 

 Recorded Dump File (one per Module) – this is the file that contains the data that was recorded, in a 
binary format. Two files are created, one for Module 0 and one for Module 1. A Dump file can be up to 1 
Giga byte.  
The filename of a dump file includes the date and time it started, the 1553 module and a serial number - 
For example – ‘Monitor_2009-03-11_09-41-36_M01_000.dump’ – this file started at 9:41am, and 36 
seconds on March 11

th
 2009, and data recorded from Module 1. In case of a long recording, there could 

be several dump files that include a single recording event. All these files will have the same name, with a 
change in 3 digits number at the end of the file (instead of 000, there would be 001, 002, 003…). 
 

 Index File – this file contains indexed information about the dump files. The filename is similar to the 
dump files, for example – ‘Monitor_2009-03-11_09-41-36.index’.  
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Those files are related to one another. A single index file contains information about all the dump files that are 
related to it. So in a long recording you would see something like: 
 

 Monitor_2009-03-11_09-41-36.index 
 Monitor_2009-03-11_09-41-36_M00_000.dump 
 Monitor_2009-03-11_09-41-36_M00_001.dump 
 Monitor_2009-03-11_09-41-36_M00_002.dump 
 Monitor_2009-03-11_09-41-36_M00_003.dump 
 Monitor_2009-03-11_09-41-36_M01_000.dump 

 
 

 Note: 

Do not attempt to manually edit the Dump, Index or the Setup files. These are binary files which have no 

meaningful information for the user.  

To stop the recording, use the  button. 

 

6.4 PLAYBACK RECORDED DATA 

Use this option to play data that was previously recorded from the bus. 

Recorded data is saved in a database that consists of two files: 

Selecting the “Playback Recorded Data” from the File menu will open the following menu: 

 

Figure 25: Playback Recorded Data 

Browse to the required INDEX file for the recorded data and press ‘OK’.  
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After opening the dump file, the software will create a new tab, with the name of the file at the top, and 

two control tabs at the bottom: 

 

Figure 26: MuxMonitor™ Open Dump File 

The control section of the Playback screen enables you to run, stop, change direction and speed of 

running. 

The behavior of the messages tab is similar to the behavior during normal monitoring – i.e. each message 

overrides the same message from the previous frame. Display Filter can also be applied here, same as in 

Monitoring, and the status LEDs are infected as well. 

You may also search for specific messages using the Search Criteria at the bottom. Setting the search 

criteria is similar to the display filter, and is discussed in chapter 6.2.2. 

When playing messages, the default speed (which is also the minimum speed) is one message per second. 

You can increase and decrease the playback speed, with a maximum of up to 256 messages per second. 
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By default, all messages are transmitted in the order they were recorded. You can change the order of 

playing the data and transmit the last message first. 

 

 

Figure 27: Playback control 

 

The following table explains the function of each control button: 

 

Go to Beginning of file – clicking will move back to the beginning of the dump file, clear the screen and 
start the playback again. 

 

Go to End of file – clicking here will move to the end of the dump file and clear the screen. 

 

Play Recorded Data Forward – click here to start playing the recorded data in the order of appearance. 

 

Play Recorded Data Backward – click here to start playing the recorded data backward. 

 

Stop playing recorded data – click here to stop playing the recorded data. 

 

One step backward – when not in play mode, click here to play the message that was recorded before 
the current message. 

 

One step forward – when not in play mode, click here to play the message that was recorded after the 
current message. 

 

Reduce Playback speed – click here to reduce the speed of playback. The minimum speed is one 
message per second and the maximum is 256 messages per second. 

 

Set Playback speed to 1 message per second – click here to set the playback speed to 1 message per 
second. This is also the default speed. 

 

Increase Playback speed – click here to increase the speed of playback. The minimum speed is one 
message per second and the maximum is 256 messages per second. 
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6.5 SEARCH FOR RECORDED MESSAGES 

You may search for specific messages by setting the search criteria. See chapter 6.2.2 for details on how to set the 

criteria. 

Once you set the search criteria you may search the message from the beginning of the file, forward from the 

point you are in the file or backward from that point. 

Every click on one of the buttons – “Search from Start”, “Search Forward” or “Search Backward”, will show the 

next message that corresponds to the search criteria. 

6.6 VERSION’S NEW FEATURES 
The following features were added to the current MuxMonitor version: 

1. On Loading Monitor 

MuxMonitor’s main window now loads without pressing New Monitor. 

Pressing File -> New monitor will open a new instance of MuxMonitor application 

2. New quick access icons menu bar 

a. Reset Device Connection 

 
Reset device connection terminates the connection to the device and re-initialize it. 

b. Launch MuxSim 

 
Runs a MuxSim Application. 

3. Device number indication 

Device number added to the top left header of the application 

4. Color Error cells 

Once Error occurred, the margins of the Errors cell in the table is colored in Red (for quick identification 

purposes) 

5. Errors Log 

The Errors Log is created to a specified folder and its name contain timestamp of the export time. 

The purpose of the log is to collect and present the first occurrence of each error recorded. 

Each error in the log is specified with timestamp and the relevant data that was presented in the Monitor. 

a. Errors Log Settings 

On Tools -> Options window, the user can browse for a folder to export Errors log to and whether 

to log the errors or not. 
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b. Errors Log Export 

On File -> Save Errors Log, the user can export the Errors log to the selected location (make sure 

that the selected path exists.) 
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7 mcxSIM™ - BATCH BASED SIMULATION FOR 1553 AND RS-485 

7.1 GENERAL DESCRIPTION 

The mcxSIM™ application creates a batch based simulation of 1553 and RS-485 busses by reading text files which 

create and control the required communications. 

mcxSIM™ can be operated in 2 modes: with a Graphical User Interface (GUI) or without a GUI. 

From the BIN directory of MultiComBox™ run ‘mcxSIM.exe’. This will open the GUI of the mcxSIM™ application and 

will start the compilation of the default command file (mcx_test1.txt). Error message will indicate if there was an 

error during compilation. If the compilation ended successfully, MultiComBox™ communication will start 

immediately. During the simulation, information will be reported to the screen and will be logged into a log file. 

Switches on the GUI and Command line arguments are controlling the details level of the report. 

mcxSIM Command line arguments: 

-file <command_file_name> -log <log_file_name> -help -NoGUI -NoLog -No1553MsgReport  

-No1553Findings -No485XmitReport -No485ReadReport -VerificationReport 

Arguments must be separated by space. All arguments are optional and have default values. 

-file <command_file_name>  

Specifies the name of the command file for the current simulation. Default command_file_name is mcx_test1.txt. 

 -log <log_file_name>  

Specifies the name of the log for the current simulation results. Default log_file_name is mcx_log.txt. 

-help  

Print Help information of the command line arguments and the available command file commands syntax. Using 

this switch will open the GUI to print the help information even if the -NoGui switch was specified. 

-NoGui  

Specifies that mcxSIM™ will run without GUI. In case there was an error during the compilation or during run time, 

the GUI will be opened to report the error. The default mode of operation is with GUI. 

-NoLog 

Disables mcxSIM™ from generating log file for the current simulation run. The default mode of operation is with 

log file. 

-No1553MsgReport 

Disables 1553 messages detailed report. The default mode of operation is with detailed report of 1553 messages. 

-No1553StsReport 

Disables 1553 messages status report. The default mode of operation is with status report of 1553 messages. 
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-No485XmitReport 

Disables RS-485 report of the transmitted data words. The default mode of operation is with report of RS-485 

transmitted words. 

-No485ReadReport 

Disables RS-485 report of the received data words. The default mode of operation is with report of RS-485 

received words. 

- VerificationReport 

Enable generation of a verification result log file (file name is mcx_VerificationLog.txt). This log file contains 

PASS/FAIL report for the executed tests in the command file. Default mode is without generation of verification log 

file. 

7.2 mcxSIM™ GUI 

 

Figure 28: mcxSIM™ GUI 
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MultiComBox™ communication details will be printed to the mcxSIM™ terminal. The same information will also be 

logged to the log file if not disabled. The terminal depth is limited to 65,000 lines, if exceeded, the first 60,000 lines 

will be deleted from the screen (this will not affect the log file). 

The mcxSIM™  GUI contains the following controls: 

Menu: 

> File- 

    -Open: Using the Open menu you may open a new command file for simulation. 

    -Exit: Terminate the simulation and close the mcxSIM™ application. 

> Help- 

    -Command Syntax: Print Help information of the command line arguments and the available command file  

      commands syntax. 

Switches: 

> 1553 Msg Report - Enable/Disable 1553 messages detailed report (equivalent to the -No1553MsgReport 

command line argument). 

> 1553 Sts Report- Enable/Disable 1553 messages Status report (equivalent to the -No1553StsReport command 

line argument) 

> 485 Xmit Report - Enable/Disable RS-485 transmitted data report (equivalent to the –No485XmitReport 

command line argument) 

> 485 Read Report - Enable/Disable RS-485 received data report (equivalent to the –No485ReadReport command 

line argument) 

> Log to File - Enable/Disable log file for the current simulation run (equivalent to the –NoLog command line 

argument) 

> Log Verification Results- Enable/Disable Verification log file for the current simulation run (equivalent to the   

–VerificationReport command line argument) 

Buttons: 

Rerun – Rerun the same simulation again from the beginning. If the Command file was changed, mcxSIM™ will 

recompile the file in order to run it. 

Clear Screen – Clear the terminal screen. (log file is not affected). 

Continue – Force simulation to continue in case it was stopped. 

Abort- Terminate current simulation run. 

Exit - Terminate the simulation and close the mcxSIM™ application. 
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Command Line: 

The Command Line interface is a mechanism for a single command type and execution. mcxSIM™ will immediately 

perform the Command Line command after pressing the ‘Enter’ key.  Pressing the Up/Down arrows while holding 

Shift key will browse the Command file commands into the Command Line, enable re-execution of a command file 

command. Pressing the Up/Down arrows (without the shift key) will retrieve previous Command Line commands.  

 

7.3 mcxSIM COMMAND FILE 

mcxSIM™ command file contains commands which create and control the MultiComBox™ communication. The 

default command file (mcx_test1.txt) is compiled immediately (if exist) at the beginning of the mcxSIM™ run. An 

error message will indicate if there was an error during compilation. The commands in the command file will be 

executed one by one sequentially.  

Important: When setting a parameter using one of the mcxSIM commands, the parameter value will remain until 

setting it again or until using the RESET command. It is recommended to use the RESET command between tests in 

order to reset all the parameters to their default value and setting them again inside each test. When using a 

TEST_PLAN, mcxSIM will automatically perform a RESET between tests. 

The STOP ON_ERROR command causes the simulation to stop on any verification error. When using this command 

it becomes active from the time it was specified till the end of the simulation. There is no way to turn it off. 

Simulation may continue after it was stopped by clicking the ‘Continue’ button. 

 

7.3.1 USING TEST PLAN 

A command file may contain one test or several tests. In case of one test, the command file will contain a sequence 

of commands to be executed. In case of several tests, a TEST_PLAN section must be included at the top of the file. 

The TEST_PLAN declaration contains a list of tests which will be executed one after the other. The tests content 

will be detailed in the same file after the END_TEST_PLAN command.  

The following commands are available inside a TEST_PLAN: TEST, SLEEP, ECHO, STOP and RERUN.  

In order to avoid a specific TEST from running you can comment it out in the TEST_PLAN. 

See examples of command files at the end of the Commands Syntax paragraph. 
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7.3.2 SETUP & CONTROL COMMANDS 

TEST_PLAN <comment> -- Test Plan declaration. Following this command will be a list of TESTs which will be 

executed one after the other.  TEST_PLAN declaration must be the first command in the file. The Test Plan section 

must end with the END_TEST_PLAN command.  

END_TEST_PLAN -- End of Test Plan section. The Test Plan section must end with the END_TEST_PLAN command. 

After this command, the file should contain TEST commands to execute upon a call from the Test Plan. 

TEST <test_name> <comment> -- Test header or Test to execute. Can be used either inside a TEST_PLAN to 

execute a test, or as a Test header before a set of commands. The <test_name> will be used to identify the test 

and to call it while using in a Test_Plan. The <comment> will be printed to the screen when executing this test. 

MODULE <0 or 1> -- Select a Module to communicate. Selection is active until next MODULE command. If not 

specified, Module 0 is the default. 

USERCODE <hex_number> -- Set MultiComBox UserCode for the active Module to control mode of operation. 

<hex_number> is a 4 digit hexadecimal code 0000 to FFFF. 

SLEEP <decimal_number> -- Sleep for <decimal_number> miliseconds. 

ECHO <text> -- Display the specified text to the screen. 

STOP [ON_ERROR] -- Stop simulation script from running. ON_ERROR is an optional parameter. If ON_ERROR is 

specified, Simulation will Stop on any verification error. Simulation can Continue or Aborted after Stopping. 

RERUN <decimal_number> -- Run simulation again from the beginning of the Test or from the beginning of the 

TEST_PLAN. <decimal_number> Number of times to rerun the simulation. If none, simulation will rerun forever. 

RESET -- Stop all Modules activity and reset all Modules parameters & settings to default values. 

EXIT -- Stop all Modules activity and close mcxSIM. 
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7.3.3 1553 COMMANDS 

SIMULATED_RT <list of numbers 0 to 31 | -1 | 99> -- Select which RTs are simulated by MultiComBox. Selection is 

active until next SIMULATED_RT command. If not specified, all RTs are not simulated. 99 = all RTs are simulated,  

-1 = all RTs are not simulated. 

LIVE_RT <0 or 1> -- Disable/Enable LIVE_RT Mode. When enabled, Live RT is active for all RTs which are not 

simulated. Selection is active until next LIVE_RT command. If not specified, LIVE_RT is disabled. 

SEQUENCE <gap | rate> -- Set mode of operation to Gap or Rate. In Gap mode the gap value in each message 

defines the time in microseconds from the beginning of a message to the beginning of next message. If Gap value 

is 0 or less than message length, then next message is sent immediately. In Rate mode, the rate value defines the 

frame rate of which messages are transmitted. Could be as follow: 0 = message is not transmitted, 1 = every frame, 

2..14 = every 2^(rate-1) frames, 15 = once. If N=2^(rate-1), then message will be transmitted in frame# N/2, 

N+N/2, 2N+N/2, etc.. for example, for rate 3 (N=4), message will be sent in frame#: 2, 6, 10, etc.. ; Mode is set until 

next SEQUENCE command. If not specified, Gap mode is the default. 

BCRT <bus> <gap/rate> <verify> <cmd> <sts> [<data0 ... data31> | <RANDOMi> i=0-99 

<number_of_random_data_words>] -- Create a BC to RT or RT to BC message. <bus> A or B ; <gap/rate> decimal 

gap value in microseconds or rate of message ; <verify> 0 | 1 | -1 : 0 don't verify, 1 verify that received data equal 

to the specified data - relevant ONLY for communication with REAL RT devices, -1 Verify No Response from the RT 

for this command ; <cmd> 4 digits Hex 1553 Command ; <sts> 4 digits Hex 1553 Status ; Either <data0 ... data31> - 

4 digits Hex 1553 Data words, Optional, if not specified, assumed 0 or <RANDOMi> i=0-99 Random data 

generation, select between 100 (0-99) optional random sets ; <number_of_random_data_words> Number of 

Random data words to generate. 

RTRT <bus> <gap/rate> <verify> <rcv_cmd> <xmit_cmd> <xmit_sts> <rcv_sts> [<data0 ... data31> | <RANDOMi> 

i=0-99 <number_of_random_data_words>] -- Create RT to RT message. <bus> A or B ; <gap/rate> decimal gap 

value in microseconds or rate of message ; <verify> 0 | 1 | -1 : 0 don't verify, 1 verify that received data equal to 

the specified data - relevant ONLY for communication with REAL RT devices, -1 Verify No Response from the RT for 

this command ; <rcv_cmd> 4 digits Hex 1553 Command to the Receive RT ; <xmit_cmd> 4 digits Hex 1553 

Command to the Transmit RT ; <xmit_sts> 4 digits Hex 1553 Status of the Transmit RT ; <rcv_sts> 4 digits Hex 1553 

Status of the Receive RT ; Either <data0 ... data31> - 4 digits Hex 1553 Data words, Optional, if not specified, 

assumed 0 or <RANDOMi> i=0-99 for Random data generation, select between 100 (0-99) optional random sets ; 

<number_of_random_data_words> Number of Random data words to generate. 

INJECT_ERROR <error_type> <msg_indx> <word_indx> <auto_inc> <error_value> -- Inject an Error in one of the 

Frame messages. <error_type> none | parity | sync ; <msg_indx> 1 - 4 : Index of the Message to insert the Error, 

Error may be injected only at 1 message out of the first 4 messages in the frame ; <word_indx> 0-35 : Word 

number in the message, starting from the Command Word (index 0), to inject the error ; <auto_inc> 0 - No Auto 

Increment, 1 : In case message is transmitted more than once, Error will be injected automatically in next possible 

location each transmission ; <error_value> depends on error type, see below: 
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- for error_type=parity, <error_value is ignored> 

- for error_type=sync, <error_value: 0-7 | F>: 0='111100', 1='110000', 2='111001', 3='011000', 4='000011',  

                              5='001111', 6='000110', 7='100111', F=Invert the standard sync of this message type 

- for error_type=bi_phase, <error_value: 0 - 16>: Index of the Bit to insert the error 

- for error_type=zero_crossing, 2 error_values are needed: <error_value1: 0 to 39> <error_value2: -8 to 7> 

GO <Xtimes> <frame_length> <continuation_condition: cont> -- Initiate MultiComBox 1553 transmission. 

<Xtimes> Number of frames to send. 0 = Forever, or 1 to 65535. <frame_length> time from the beginning of this 

frame to the beginning of next frame in milliseconds. 1 to 65535, if 0 or none, frames run back to back ; 

<continuation_condition> Set GO Command continuation_condition, 'cont' will cause mcxSIM to continue to the 

next command without waiting till the end of the GO command communication (relevant for MRT mode), if this 

parameter is not specified mcxSIM will continue to the next command only after the end of the GO command (end 

of the frame transmission). 

MODULE_LOOP_BACK_TEST <times> <verify_A0_A1> <verify_B0_B1> --Perform external self test for valid 

communication between Module0 busses to Module1 busses and vice versa. A short connection between 

Module0 busses to Module1 busses (A0-A1, B0-B1) is required to perform this test. <times> Number of tests to 

perform, each test consist of 1 frame transmission in all 4 options (A0->A1, B0->B1, A1->A0, B1->B0); 

<verify_A0_A1> 0 don't verify, 1 verify valid transmission from Module0 bus-A to Module1 bus-A and vice versa; 

<verify_B0_B1> 0 don't verify, 1 verify valid transmission from Module0 bus-B to Module1 bus-B and vice versa. 

BUS_LOOP_BACK_TEST <times> --Perform external self test for valid communication between Active Module 

busses A<-->B. A short connection between bus-A and bus-B of the Module under test is required to perform this 

test. <times> Number of tests to perform, each test consist of 1 frame transmission. 

7.3.4 RS485 COMMANDS 

485_SETUP <channel> <mode> <word_length> <parity_type> <stop_bit_type> <freq_divider> -- Setup Channel 

Parameters for the RS-485 Xmit & Receive communication. <channel: ch1 | ch2 | ch3 | ch4> Selected channel for 

setup (ch1 = module0 line0, ch2=module0 line1, ch3=module1 line0, ch4=module1 line1) ; <mode: TxOnly | TxRx> 

Set channel communication direction: TxOnly = channel can xmit only - forced to '1' when idle, TxRx = Channel can 

xmit & receive - forced to 'Z' when idle ; <word_length> Number of bits in a word: 5 - 9 ; <parity_type> Type of 

parity bit: even, odd or none ; <stop_bit_type> Type of stop bit: 1 | 1.5 | 2 ; <freq_divider> 

Communication_Frequency = 30Mhz / freq_divider, decimal_number > 2. 

485_XMIT <channel> <num_of_words> <data0 .... data100> -- Initiate MultiComBox RS-485 transmission. 

<channel> Selected channel for transmission: ch1 | ch2 |ch3 | ch4 ; <num_of_words> Number of words to 

transmit up to 100 ; <data0 .... data100> 2 or 3 digits hex data words, The number of data words should be equal 

or higher than <num_of_words>. 

485_XMIT_INC <channel> <num_of_words> <data0> -- Initiate MultiComBox RS-485 transmission with 

incremental data. <channel> Selected channel for transmission: ch1 | ch2 |ch3 | ch4 ; <num_of_words> Number 

of words to transmit up to 1000 ; <data0> Value of first word: 2 or 3 digits hex data word, next data words value 

will automatically incremented by 1 till <num_of_words> are transmitted. 
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485_READ <channel> <verify> <num_of_words> <data0 .... data100> -- Read MultiComBox RS-485 received data, 

if the requested num_of_words was not received yet, a warning will be issued. <channel> Selected channel for 

data retrieve: ch1 | ch2 |ch3 | ch4 ; <verify> 0 don't verify, 1 verify that received data is equal to the specified data 

; <num_of_words> Number of words to read up to 100, Warning will be issued if <num_of_words> is higher than 

what been actually received so far ; <data0 .... data100> Specified data words for verification: 2 or 3 digits hex data 

words. 

485_READ_INC <channel> <verify> <num_of_words> <data0> -- Read MultiComBox RS-485 received data with 

incremental data, if the requested num_of_words was not received yet, a warning will be issued. <channel> 

Selected channel for data retrieve: ch1 | ch2 |ch3 | ch4 ; <verify> 0 don't verify, 1 verify that received data is equal 

to the specified data ; <num_of_words> Number of words to read up to 1000, Warning will be issued if 

<num_of_words> is higher than what been actually received so far ; <data0> Value of first word: 2 or 3 digits hex 

data word, next data words value will automatically incremented by 1 till <num_of_words> were read. 

485_RCV <channel> <verify> <num_of_words> <data0 .... data100> -- Receive MultiComBox RS-485 data, if the 

requested num_of_words was not received yet, the script will hold until received. <channel> Selected channel for 

data retrieve: ch1 | ch2 |ch3 | ch4 ; <verify> 0 not verify, 1 verify that received data is equal to the specified data ; 

<num_of_words> Number of words to receive up to 100, the script will hold until the requested <num_of_words> 

will be received ; <data0 .... data100> Specified data words for verification: 2 or 3 digits hex data words. 

7.3.5 mcxSIM COMMAND FILE EXAMPLES 

 The following command file contains a single test for RT to BC communication. Module0 of the MultiComBox 

is the BusController. There is one message in the frame from RT2 to the BC with 4 data words. Verification 

switch in the BCRT command is set (‘1’). As a result after receiving the relevant message from the RT, mcxSIM 

will verify that these words equal to the expected words in the BCRT command (x2001 – x2004), the Status 

word will also be verified (x1000): 

Test rt2bc Module0-BC 

MODULE 0 

USERCODE 0000 

SEQUENCE gap 

SIMULATED_RT -1 

 #msg1: RT2 to BC, SA20, 4words, bus A 

 BCRT  A 0 1 1684 1000  2001 2002 2003 2004 

GO 1 20 

 

 The following command file contains a Test Plan with 2 tests. The first test is the same rt2bc test from the 

previous example; the second test is a bc2rt test contain 1 message frame from the BC to RT30, with 32 

random data words. Verification switch in the BCRT command is set to verify the return Status word (xF000). 

TEST_PLAN 

 Test rt2bc 

 Test bc2rt 
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 # RERUN 2 

END_TEST_PLAN 

 

 

Test rt2bc Module0-BC, RT2 to BC, SA20, 4words, bus A 

MODULE 0 

USERCODE 0000 

SEQUENCE gap 

SIMULATED_RT -1 

 #msg1: RT2 to BC, SA20, 4words, bus A 

 BCRT  A 0 1 1684 1000  2001 2002 2003 2004 

GO 1 20 

 

Test bc2rt Module0-BC, BC to RT30, SA15, 32 random words, bus A 

MODULE 0 

USERCODE 0000 

SEQUENCE gap 

SIMULATED_RT -1 

 #msg1: BC to RT30, SA15, 32 random words, bus A 

 BCRT  A 0 1 F1E0 F000  random1 32 

GO 1 20 

 

7.4 OPERATING MULTIRT IN MCXSIM™  

The following setup is required when operating MRT in mcxSIM using mcxSIM commands: set the relevant Module 

to MRT mode, enable the desired RTs for emulation, set the frame messages, run forever with 

continuation_condition set in order to continue to the next command in the control script. 

See example script: 

The following script set Module 1 as MRT and Module 0 as BC, using a short cable between module 0 and module 1 

busses, Module 0 (BC) will initiate a RT to BC communication (single message frame ) from module 1 (MRT). 

Test rt2bc Module0-BC, Module1-MRT 

## Module1 MRT 

MODULE 1 

USERCODE 0002 

SEQUENCE gap 

SIMULATED_RT 99 

 #msg1: RT0 to BC, SA1, 32words, bus A 

 BCRT  A 0 1 0420 0000  random0 32 

GO 0 20 cont 

 

## Module0 BC 

MODULE 0 

USERCODE 0000 

SEQUENCE gap 

SIMULATED_RT -1 

 BCRT  A 0 1 0420 0000  random0 32 
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GO 1 20 

Please be aware to the cont parameter in the MRT GO command. Without this parameter, mcxSIM will wait until 

the end of the GO command before continuing to the next command in the script. Since we initiate the MRT 

module with GO forever command (GO 0), the MRT communication will actually never ended and therefore we 

have to include the cont parameter in order to instruct mcxSIM to continue without waiting till the end of the GO 

command. 

MRT mode (run forever) can be aborted using a new USERCODE command to the same module, or using the 

mcxSIM RESET command. 
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8 TROUBLESHOOTING 

TBD 
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9 ORDERING INFORMATION 
 
TST1553USB-2-4-B 

 

Part Number Internal Memory 

B (or blank) Basic configuration – 1553 + serial 
EBR Support for Extended Bit Rate 1553 
HP Support for H009 and PP194 

  

Part Number Serial Channels (RS-485) 

0 (or blank) No serial channels 
4 4 x serial channels 

  

Part Number 1553 Channels 

1 (or blank) 1 x dual-redundant 1553 channel 
2 2 x dual-redundant 1553 channels 
  

 

Available configurations are: 

 TST1553USB-2-4-B (2 x 1553 + 4 x RS-485) 

 TST1553USB-2-4-EBR (2 x 1553 + 4 x RS-485 or 4 x EBR1553) 

 TST1553USB-2-4-HP (2 x 1553 or 1 x 1553 + 1 x PP194 or H009 + 4 x RS-485) 

 TST1553USB-1-0 (1 x 1553) 
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17 Atir Yeda St., Kfar-Saba, ISRAEL 44643 

Email: info@sitaltech.com 

Website: http://www.sitaltech.com 

 

The information provided in this User’s Guide is believed to be accurate; 
however, no responsibility is assumed by Sital Technology for its use, and 
no license or rights are granted by implication or otherwise in connection 
therewith. Specifications are subject to change without notice. 
 
Please visit our Web site at www.sitaltech.com for the latest information. 
 
© All rights reserved. No part of this User’s Guide may be reproduced or 
transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written 
permission by Sital Technology. 
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